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CZ Print Job Tracker 6.0 — User Guide

If you have any questions, please send email to support@czsolution.com, or fill out the form at
http://www.czsolution.com/print-management/support.htm or call us.

Part | Components, Requirements and Installation Instructions (Page 2 ~ 19)

CZ Print Job Tracker 6.0 (Required) CZ Print Job Tracker 6.0 is a powerful centralized print manager &
print counter for Windows NT/2000/XP/2003/Vista/2008/Windows 7 print-server printing environments
and non-print-server printing environments (In the case of the non-print-server printing environment, users
send the print jobs to the printer directly via the IP address of the printer or the printer that is connected to
the workstation locally, instead of the shared printer on the print server). (Page 2 - 4)

CZ Print Job Agent 1.0 (Optional Add-on) CZ Print Job Agent allows users to check their balance on
their workstation, confirm or authenticate their print jobs from their workstations (Windows, Mac OSX /
Classic, or Linux client) before they actually print, bill the print jobs by entering a client code or project
code, and track the print jobs on the workstation-connected-printers or the printers themselves in a non-
print server printing environment (Users send the print jobs to the printer directly via the IP address of the
printer, instead of the shared printer on the print server). This software must be installed on the
workstations that require the above features. (Page 5 ~ 13)

CZ Print Job Report 4.0 (Optional Add-on) CZ Print Job Report is a tool which allows you to generate
and view 100 reports including 64 default reports and 36 customized reports, and provides the ability to
export these reports to Adobe-PDF, MS-Word, MS-Excel and Rich Text formats. These reports are
originally written in English, but can be easily translated into any language which takes just a few minutes.
(Page 14~ 15)

CZ Remote Account Manager 1.0 (Optional Add-on) CZ Remote Account Manager allows you to add /
edit users / billing code / client code / project code, update account balance / quota / group / pin from any
computer. (Page 16)

CZ Print Release Station 3.0 (Optional Add-on) for Windows 2000/XP/2003/Vista/2008/Windows 7 is
installed next to the printer and holds the print jobs until user releases the jobs. The print jobs can be
released by the user’s identity or password to improve confidentiality. The print jobs can also be released
after user makes payment. (Page 17 ~ 19)

Part Il Installation Options and Examples (Page 20 ~ 33)

Installation Options and Examples that require only CZ Print Job Tracker 6.0

If you don’t need the features that CZ Print Job Agent provides, you can just install CZ Print Job Tracker
6.0 only.

Option 1: Install CZ Print Job Tracker 6.0 on a central computer (Page 20)

Option 2: Install CZ Print Job Tracker 6.0 on your current print server computers (Page 21)

Installation Options and Examples that require both CZ Print Job Tracker 6.0 and CZ Print Job
Agent 1.0

Option 3: Install CZ Print Job Tracker 6.0 on a central computer and install CZ Print Job Agent on the
workstations (Page 22)

Part 111 Preferences (Page 34 — 42)
Part IV Step by Step Configuration and FAQ (Page 43)
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Part | Components, Requirements and Installation Instructions

CZ Print Job Tracker 6.0 (Required

CZ Print Job Tracker 6.0 System Requirements

Operating System Windows 2000/XP/2003/Vista/2008/Cluster Server/Windows 7
CPU 300 Mh or higher
Memory 256 MB or more

Hard Disk Free Space 10M

In order to install CZ Print Job Tracker 6.0, you must have the administrator rights on the installation
computer. You also need the administrator rights on all monitored printers in order to be able to control the
print jobs.
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1. Double-click setup.exe and follow the on-screen instructions.

Note: If CZ Print Job Tracker is installed on Windows Vista / Windows 7 / Windows 2008, go to the
installation folder (e.g. C:\Program Files\CZ Solution\CZ Print Job Tracker), right click “PJAdmin.exe”,
then click “Properties”, select “Compatibility” tab, set "Run this program as an administrator"” in Privilege
Level and Click "Change settings for all users" button, Set "Run this program as an administrator” in
Privilege Level in "Compatibility for all users" tab. Repeat this for "PrintSaver.exe".
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2. After the installation completes, double-click the shortcut “CZ Print Job Tracker 6.0” on your desktop or
select "Start > Programs - CZ Solution - CZ Print Job Tracker 6.0" to run the program.

3. You can make CZ Print Job Tracker run as a windows service regardless of whether someone is logged
on by clicking the menu item “Tools = Install CZ Print Job Tracker Service”, then go to Control Panel-
>Administrative Tools-->Services-->CZ Print Job Tracker, change the Local System account to the account
with which you added all network printers in Printers and Faxes (or Devices and Printers) and has
administrator rights on all network printers, then restart the CZ Print Job Tracker service. If you install CZ
Print Job Tracker on Windows Cluster server, Please configure CZ Print Job Tracker in the group as a

""generic service".
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Uninstall CZ Print Job Tracker 6.0

1. If CZ Print Job Tracker service is installed, click the menu item “Tools = Uninstall CZ Print Job
Tracker Service.”

2. Open Add/Remove Programs, select CZ Print Job Tracker, and click on the Remove button, then restart
the computer.

3. Remove the installation folder. (E.g. C:\Program Files\CZ Solution\CZ Print Job Tracker)



CZ Print Job Agent 1.0 for Windows, Mac OS X/Classic and Linux x86 (Optional Add-on)
CZ Print Job Agent must be installed on those workstations (Windows, Mac, or Linux client) that:

1. Print jobs which must be confirmed or authenticated before they actually print

2. Print jobs which must be billed to clients or projects by entering client code or project code before they
actually print

3. Print jobs which must be tracked and logged for workstation-connected printers or the printers in a
non-print server printing environment (Users send the print jobs to the printer directly via the IP
address of the printer, instead of the shared printer on the print server).

4. Users must be able to check their balance on their workstations.

CZ Print Job Agent 1.0 for Windows

CZ Print Job Agent System Requirements I

Operating System Windows 95/98/2000/XP/2003/Citrix/Vista/2008/Windows 7
CPU 300 Mh or higher

Memory 256 MB or more

Hard Disk Free Space 2M

Note: For testing purpose, you can install CZ Print Job Agent on the same computer that has CZ Print Job
Tracker installed, so it is easy for you to make testing. In production environment, please remove CZ Print
Job Agent from the computer where CZ Print Job Tracker is installed.

Note: Before you run CZ Print Job Agent, please make sure CZ Print Job Tracker 6.0 is running on a
central computer or print server and the option “Enable agent communication” is checked in the menu item
“Print Jobs > Preferences - Advanced.” If the firewall is enabled on the computer that has CZ Print Job
Tracker installed, please add an exception for printczm.exe that is in the installation folder of CZ Print Job
Tracker e.g. C:\Program Files\CZ Solution\CZ Print Job Tracker.
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Note: You must have administrator rights on the workstations in order to install CZ Print Job Agent.

Local Installation
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1, Double click CZ Print Job Agent.msi, then follow the on-screen instructions.

3. After the installation completes, select "Start - Programs - CZ Solution - CZ Print Job Agent" to run
the program. Note: CZ Print Job Agent can be started automatically when the user logins next time.

4. Enter the IP Address of the CZ Print Job Tracker computer.

.z CZ Print Job Agent 1.0.0.66

IP Address F Computer Mame

Pleaze make sure CZ Print Job Tracker iz running and the option "Enakle agent communication” is
checked inthe menu item "Freferences --= Advanced" of CZ Print Job Tracker.
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Note: This information is required when you run CZ Print Job Agent on the workstations the first time
and it will be saved in both the file tracker_ip.ini located in the installation folder of CZ Print Job Agent
and the value data of the string CZPJT _IP in the registry key: My ComputenHKEY _LOCAL _
MACHINE\SOFTWARE\CZ Print Job Agent. (CZ Print Job Agent.msi or CZ Print Job
Agent_Silent_Install.msi can be modified to include the computer name or IP Address of your CZ
Print Job Tracker by using Orca utility, so you don’t have to enter it manually when CZ Print Job
Agent is started the first time. Please check the following Silent installation step 1).

Note: The local firewall settings on Windows may prevent agent from connecting to server (CZ Print Job
Tracker). Please add "pagent.exe" (e.g. C:\Program Files\CZ Solution\CZ Print Job Agent\pagent.exe)
exception in firewall settings (Control Panel - Windows Firewall).
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5. (Optional) If CZ Print Job Agent is installed on a Citrix /Terminal server, the file "terminal” must be
deleted from the installation folder of CZ Print Job Agent on that Citrix / Terminal server. (E.g.
C:\Program Files\CZ Solution\CZ Print Job Agent). This file will be created automatically when you run
the agent first time.

The file "document” must be deleted from the installation folder of CZ Print Job Agent on those
workstations where print job / document name is allowed to be changed (E.g. C:\Program Files\CZ
Solution\CZ Print Job Agent). This file will be created automatically when you run the agent the first
time. After the file is deleted, you must restart the agent. In CZ Print Job Tracker 6.0 Preferences ->
dvanced, the option “Allow to change the print job (document) name on defined workstations” must be
checked.

Silent Installation

1. Modify CZ Print Job Agent_Silent_Install.msi package to include the name or IP address of the
computer where you installed CZ Print Job Tracker 6.0, so you don’t have to enter it manually when you
run CZ Print Job Agent the first time on each workstation.

We recommend using ORCA utility (part of the Windows Installer SDK) to do this.
1.1 Download the orca.msi from http://www.czsolution.com/download/orca.msi .
1.2 Double click it to install Orca.
1.3 Run Oreca,
click the menu File = Open to open CZ Print Job Agent_Silent_Install.msi,
click menu Edit - Find, enter CZPJT_IP,
click the value of CZPJT _IP,
type the name or IP address of the computer where CZ Print Job Tracker 6.0 is installed.
1.4 Click the menu File->Save, then exit Orca.
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2. Double click CZ Print Job Agent_Silent_Install.msi to install CZ Print Job Agent. You can also use
Windows group policy or third party installation software to remotely install CZ Print Job Agent on
workstations. For remote installations, please  visit http://www.czsolution.com/print-
management/remoteinstall.htm

3. After the installation is complete, select "Start = Programs = CZ Solution = CZ Print Job Agent" to
run the program or you can logout the computer and login back and CZ Print Job Agent will run
automatically.

Note: The IP Address or name of the CZ Print Job Tracker computer is saved in the registry key: My
ComputenHKEY_LOCAL_MACHINE\SOFTWARE\CZ Print Job Agent\ CZPJT_IP. When running CZ
Print Job Agent, it will get the value from the registry and connect to CZ Print Job Tracker. The value in
the registry can be overwritten if a value is defined in the file tracker_ip.ini.

Note: A shortcut is created in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run, so CZ Print Job
Agent can run automatically when users logs on.

Note: Orca can also be used to modify local installation package CZ Print Job Agent.msi package to
include the name or IP address of the computer where you installed CZ Print Job Tracker 6.0, so you
don’t have to enter it manually when you run CZ Print Job Agent the first time on each workstation
(Local Installation Step 4)

CZ Print Job Agent Known Issue

The popup doesn't appear when user prints. How to fix it?
CZ Print Job Agent doesn’t track the the direct IP printer or workstation connected printer via USB
cable. How to fix it??
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Solution 1:

If the popup on all client computers doesn't work, the local firewall settings may block CZ Print Job
Tracker to send the message to the agent. On the computer that has CZ Print Job Tracker installed, add
"printczm.exe" (e.g. C:\Program Files\CZ Solution\CZ Print Job Tracker\printczm.exe) to the exception list
of local firewall settings (Control Panel -> Windows Firewall).
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Solution 2:

The Windows firewall settings (Start --> Control Panel --> Windows Firewall) on client computer may
block agent to connect to server (CZ Print Job Tracker). When agent is installed and run first time, it will
be added to the exceptions automatically. If not, please add "pagent.exe” (e.g. C:\Program Files\CZ
Solution\CZ Print Job Agent\pagent.exe) to exception list of local firewall settings (Control Panel ->
Windows Firewall). You can also use group policy to add pagent.exe to the exceptions of Firewall settings
on multiple computers at one time at http://www.czsolution.com/print-management/agentexception.htm .
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Solution 3:

If the print job agent installed on the client computer doesn't show active in CZ Print Job Tracker
Preferences --> Advanced --> Check Agent Status, go to client computer, find and run C:\Program
Files\CZ Solution\CZ Print Job Agent\serverip.exe. If the IP address of CZ Print Job Tracker server is not
correct, please enter the correct one and click OK button, then check CZ Print Job Tracker Preferences -->
Advanced --> Check Agent Status again.
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The antivirus software firewall settings may block agent to connect to server (CZ Print Job Tracker). Please
add "pagent.exe” (e.g. C:\Program Files\CZ Solution\CZ Print Job Agent\pagent.exe) to exception list of
antivirus firewall settings or add exception for TCP port 14128.

Solution 5:

Please check the number of users in Preferences -> Users / Groups and the number of printers in
Preferences --> Printers -> List of Monitored Printers, then check how many users and printers your license
includes in menu Help -> Registration -> Enter / Upgrade License Code. For example your license is for
"50 Users & 5 Printers". If the number of users in Preferences -> Users / Groups is already 50, then the
print job for 51th user will not be tracked and the popup will not show. Please remove some users in
Preferences -> Users / Groups (and restart the CZ Print Job Tracker service if it is installed), then test it

again.
Solution 6:

If popup still doesn't appear after you try above solutions and iCZ Print Job Agent is installed on Windows
Vista / Windows 2008 / Windows 7, uncheck "Internet Protocol Version (TCP/IPv6)".
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Solution 7:

If popup doesn't appear on all client computers, click CZ Print Job Tracker menu item "Print Jobs -->
Backup / Reset Database" to backup and reset the database. If you can't see the menu item "Print Jobs -->
Backup / Reset Database", exit CZ Print Job Tracker, rename the file C:\Program Files\CZ Solution\CZ
Print Job Tracker\config\setdb to a different name, then start CZ Print Job Tracker again.

Uninstall CZ Print Job Agent 1.0
Open Add/Remove Programs, and select CZ Print Job Agent, and click on the Remove button.

Note:You can also use Windows group policy or third party installation software to remotely uninstall CZ
Print Job Agent from the workstations.
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CZ Print Job Agent 1.0 for Mac OS X / Classic and Linux x86

Mac or Linux workstations must print to the shared printer on windows print server in order for the Agent

to work:

LPR printing

1. Start the “Print Services for Unix” on your Windows Print server. If you can’t find this service, please
add it from add /remove programs = add / remove windows components = Other Network Files and

Print Services = Print Services for Unix.
2. On the Mac, add a LPR printer

3. Enter the windows print server name in Printer Address and the name of the shared printer in Queue

Name

Or you can click “+” button in Printers and Fax folder, then click “Windows” button to browse the

shared printer on the Windows Print Server.
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= HP Designjet T770

(" Oueerir la liste d'attente d'lmpﬂ-s:lm...\_

Options et Fournifwres. .

Emplacement
Type : Imprimants Posis gl géeligue

Eiat : ingciif

__| Partaper cette imprimante sur le réseau
{ Prélirences Parlage... |

—_—

D_

Imprimarte par défaut - [ 192.168.1.76

Format de papier par défaut - | Ad

3
[

JJ Pour empdcher les modiflcaions, cligaes ki, @
[ Bl =] Ajouter wne imprirante

& & a

- — —
Par céfpar  Fas IP Roerhercher

printserver r | T 7 Ot 777D

wowkgroup

Mom ; Adcune selecior
Emplacemsent @ Aucune sélecton

Imprimier via

SMB printing
Edit / etc » cups » printers.conf file
<DefaultPrinter printer>
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Location yourdomain

DeviceURI smb://yourdomain_username:password@yourdomain/printserver/printer_share_name
State Idle

Accepting Yes

</Printer>

To get the best result, please do the following:

1. Install CZ Print Job Tracker on your current Windows print server.

2. In Control Panel--> Printers, right click the shared printer, open the properities of the printer -->
Advanced, uncheck "Enable advanced printing".

3. Turn off spool file sharing for the shared printer. Please see http://www.czsolution.com/print-
management/pjt_faqg.htm#20 for details.

4. Rename c:\program files\cz solution\cz print job tracker\config\sparse0 to sparse.

5. Delete or rename file C:\Program Files\CZ Solution\CZ Print Job Tracker\config\linmac.

Falders X Hame
L) CZPrintJobTrackervpi n Hczprinticbagent.app tar
=l |23 Addon_CZ Prink Job Aigent
= | Linux_x86
= | Mac_O5¥_or_Chassic
= P Print obfgent 1
[3) CZPrirt JobAgert2
) Windows
) Addon_CZ Prink Job Report
() Addar_CZ Prink Release Skakion
() Addon_CZ Remobe Account Manad
[ User Guide

Mac OS X/Classic: CZPrintJobAgent.app.tar

1. Copy Addon_CZ Print Job Agent\Mac_OSX_or_Classic\CZPrintJobAgent.app.tar to Mac computer.

2. Double click CZPrintJobAgent to run it. If it doesn’t run, try a different agent. The host hame of the
Mac must be in the format of computerName.local (for example: m123.local where m123 is the
computer name of the Mac). If not, the popup may not work. The HOSTNAME can be defined in
/etc/hostconfig. Restarting the daemon, or rebooting, will result in the hostname command working as
expected.

3. You can make agent run automatically when Mac machine starts up:

Option 1:

Step 1: Find the CZPrintJobAgent application icon and click on it.

Step 2: Click on the File menu and select Make Alias. Drag the alias to the desktop where you can get at it.
Step 3: Double-click to open the System Folder and locate the Startup Items folder.

Step 4: Drop the alias into the Startup Items folder. The next time you start up your Mac, the application
will launch.

Option 2:
Go into the system preferences - accounts - login items, you can adjust what programs load and don't load
at sign in.

Linux x86: CZPrintJobAgent

1. Copy folder CZPrintJobAgent.
2. In terminal mode, run ./CzPrintJobAgent
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CZ Print Job Report 4.0 (Optional Add-on)

CZ Print Job Report is a tool which allows you to generate and view 100 reports including 64 default
reports and 36 customized reports, and provides the ability to export these reports to Adobe-PDF, MS-
Word, MS-Excel and Rich Text formats. These reports are designed for your print cost analysis and client
billing, and are originally written in English, but can be easily translated into any language which takes just
a few minutes.

CZ Print Job Report 4.0 System Requirements

Operating System Windows 98/2000/XP/2003/Vista/2008/Windows 7
CPU 300 Mh or higher
Memory 128 MB or more

Hard Disk Free Space  40M

If CZ Print Job Report and CZ Print Job Tracker are installed on the same computer, the database file
“printSaver.mdb” is located in the installation folder of CZ Print Job Tracker. (e.g. C:\Program Files\CZ
Solution\CZ Print Job Tracker). If you install CZ Print Job Report and CZ Print Job Tracker on different
computers, you can share the database folder from the computer where CZ Print Job Tracker is installed,
CZ Print Job Report can connect to the shared database remotely (on the second computer) to generate
reports. (e.g. W\CZ Print Job Tracker Computer Name\Shared Database Folder\printSaver.mdb.

Folders x Marme
= [0 CZPrinklobTrackerpi a2 UserGuide.txt
+ |5 &ddon_CZ Print Job Sgent L1 CFPrintJobReport. exe

3 addon_CZ Print Job Repaort "-T;!CZF'rintJDbREpDrtl o=
) Addon_CZ Prink Release Skakion

) Addon_CZ Remate Account Manager

) User Guide

1. Double click "CZPrintJobReport.exe" or "CZPrintJobReportl.exe" to install CZ Print Job Report.
CZPrintJobReport.exe is based on NET Framework 2.0 or later. CZPrintJobReportl.exe is based on NET
Framework 1.1. You can use either one to install CZ Print Job Report 4.0.

2. Follow the on-screen instructions.

3. After the installation completes, double-click the shortcut “CZ Print Job Report” on your desktop or
select "Start - Programs - CZ Solution - CZ Print Job Report" to run the program.

4. Select the included sample databases to test how it works. The sample database named
“printSaver_Sample.mdb” is located in the installation folder of CZ Print Job Report. (E.g. C:\Program
Files\CZ Solution\CZ Print Job Report). The real database file “printSaver.mdb” is located in the
installation folder of CZ Print Job Tracker (e.g. C:\Program Files\CZ Solution\CZ Print Job Tracker).

Note: If you install CZ Print Job Report on Windows 98, please Copy Dbghelp.dll from
http://www.czsolution.com/download/Dbghelp.dll and place it in the Windows\System32 folder of the
Windows 98 computer.

Check http://www.czsolution.com/print_management/czreport.htm for more information.
Uninstall CZ Print Job Report 4.0
1. Open Add/Remove Programs.

2. Select CZ Print Job Report.
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3. Click on the Remove button.

CZ Print Job Report Known Issue

| get the database logon prompt when | generate reports. How can | fix it?

Database Login x|

tdain Report
Table Hame: Frint) obs

Server Name:

D atabaze: |E:\T empsarintS aver mdb j

Login ID: I

Password: I

< Back | Finish I Cancel

Option 1:

1. Click "Select Database" to select the sample database "printSaver_Sample.mdb" that is located in the
installation folder of CZ Print Job Report e.g. C:\Program Files\CZ Solution\CZ Print Job Report.

2. Click "Generate Report" and select a report from the dropdown list. If the report is generated correctly,
then select the real database e.g. the database file in the installation folder of CZ Print Job Tracker.

Option 2:

If you have MS-Access 2007 installed on your computer, you can use it to open the database file e.g.
C:\Program Files\CZ Solution\CZ Print Job Tracker\printsaver.mdb, then in CZ Print Job Report, click
"Select Database" and "Generate Report" to see if you can see the report.

Option 3:

1, Install CZ Print Job Report on a different computer

2, Share the database folder from the computer where CZ Print Job Tracker is installed (e.g. C:\Program
Files\CZ Solution\CZ Print Job Tracker).

3. Map the network share folder from the computer where CZ Print Job Report is installed (e.g. \CZ Print
Job Tracker Computer Name\Shared Database Folder).

4, Click "Select Database" in CZ Print Job Report and connect to the shared database (e.g. WCZ Print Job
Tracker Computer Name\Shared Database Folder\printSaver.mdb).
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CZ Remote Account Manager 1.0 (Optional Add-on)

CZ Remote Account Manager allows you to add / edit users / billing code / client code / project code,
update account balance / quota / group / pin from any computer.

CZ Remote Account Manager 1.0 System Requirements

Operating System Windows 98/2000/XP/2003/Vista/2008/Windows 7
CPU 300 Mh or higher
Memory 128 MB or more

Hard Disk Free Space 1M

Before you run CZ Remote Account Manager, please make sure CZ Print Job Tracker 6.0 is running on a
central computer or print server and the option “Enable agent communication” is checked in the menu item
“Print Jobs = Preferences - Advanced.” You must also have administrator rights on the computer where
you install CZ Remote Account Manager.

Folders x Marmne
= |5 CZPrinkJobTrackervpi . ﬁ!cz Remate Account Manager. msi
4 |} Addon_CZ Print Job Agent
|Z) Addon_iZZ Print Job Report
| Addon_CZ Print Release Skakion
) Addon_CZ Remaote Account Manager
| User Guide

1. Go to CZ Remote Account Manager folder and double-click “CZ Remote Account Manager.msi”.

2. Follow the on-screen instructions.

3. After the installation completes, double-click the shortcut “CZ Remote Account Manager” on your
desktop or select "Start - Programs -> CZ Solution - CZ Remote Account Manager " to run the
program.

4. Enter the name or IP address of the CZ Print Job Tracker computer.

Note: This information is required when you run CZ Remote Account Manager on the workstations the
first time and it will be saved in the file tracker _ip.ini located in the installation folder of CZ Remote
Account Manager.

5. Click the button “Verify Remote Account Manager Password”. The password is defined in “Preferences
-> Print Jobs” of CZ Print Job Tracker.

Uninstall CZ Remote Account Manager 1.0

1. Open Add/Remove Programs.

2. Select CZ Remote Account Manager.

3. Click on the Remove button.
4,
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CZ Print Release Station 3.0 (Optional Add-on)

The optional add-on Print Release Station can holds the print jobs until user releases the jobs. It can also be
installed on an admin's computer for admin to approve the print job.

Print Release Station provides you easy print control and has admin mode and user mode.

* The print jobs can be released in admin mode by a "super user".

* The print jobs can be released in user mode without entering the user's identity or password.

* The print jobs can be released in user mode by entering Windows Active Directory account and
password.

* The print jobs can be released in user mode by entering Account and PIN defined in CZ Print Job Tracker
Preference --> Users / Groups.

* The print jobs can be released in user mode after user makes payment. The self-support payment
collection by coins, cards, bill self-service systems are most suitable.

CZ Print Release Station 3.0 System Requirements

Operating System Windows 2000/XP/2003/Vista/2008/Windows 7
CPU 300 Mh or higher

Memory 128 MB or more

Hard Disk Free Space 10M

Before you run CZ Print Release Station, please make sure CZ Print Job Tracker 6.0 is running on a central
computer or print server and the option “Enable Print Release Station” is checked in the menu item “Print
Jobs = Preferences - Advanced” and at least a printer is selected for CZ Print Release Station. You must
also have administrator rights on the computer where you install CZ Print Release Station.

references
Printers ] Print Jobs ] Users f Groups | Policies ]
Print Job Agent [Print Job Matification / Authentication £ Client Billing)
[~ Enable agent communication
-
-
-
-
-
r e | . . .
l_ ,— Add Frinters for Print Relzaze Station
r j Refresh
r WPrintServer AP
r WPrintServer!'HP Color Laserd Add
HP LaserJet 5150 Seties PCLG
{ { i
Herox Phaser B250DP PS Remave
r r
r oK,
-
r Cancel
r r r [ &
r I~
-
-
-
Print Releaze Station
Iv Enable print rel tation [hald the print job until it is releaszed manually) Printers
< ¥
Save | E xit |
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Folders X Mame

= 23 CZPrintJobTrackervpi ~ ﬁ!cz Print R.elease Station. msi
| addon_CZ Print Job Agent:
| Addon_CZ Print Job Report
] Addon_CZ Prink Release Station
I Addon_CZ Remote Account Manager
I3 User Guide

1. On a computer you select to be a Print Release Station, double-click “Print Release Station.msi and
follow the on-screen instructions.

2. On the Print Release Station, choose Start -> Printers and Faxes (or Devices and Printers). click Add a
printer to add the network printers.

'® Printers and Faxes

File Edit ‘iew Fawaorites  Tools  Help

\_’j \_/I LE }_\J Search H Folders v

. Address |I:__Q Printers and Faxes

MName Dacuments
Printer Tasks £# 4P on PrinkServerl 0

Add = printer Es2 HP Color LaserJet on PrinkServerl 1]

& Set up faxing

3. After the installation completes, double-click the shortcut “Print Release Station” on your desktop or
select "Start - Programs - CZ Solution - Print Release Station " to run the program.

4. Enter the name or IP address or computer name of the CZ Print Job Tracker computer in Preferences,
and click “Connect” button, then click "Get Settings" to get printer information from CZ Print Job Tracker.
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Print Re on 3.0.0 Admin Mode - Release Statio 0.0
Ty % i Freferences l
\ELI &:é [— — E Computer Mame of CZ Print Job Tracker © fserver!
Refresh Print Cancel Cancel All | Preferences
=% Print Jobs User | Computer | Gt Setings | Remove_|
A Wai‘(ing Jobs Monitored Printers Hel
€ Deleted Jobs Printer | Basze Cost | Duplex % | Color %
1} Printed Jobs WhPrintServert P 010 -20 +50
nd WhPrintServer! WHP Color Laserlet 3600 010 -20 +50
< | =
Uszer Mode
Show waiting jobs by * UserlD ¢ Computer Name
v Auto refresh waiting jobs every B0 seconds
Password for switching back to Admin Mode when preszing ‘Al and 'a' keps admin
[v Lock the desktop in User Mode
[ Auto switch to uzer mode when starting the application
™ Require users to enter user |d or computer name ta show only their print jobs
Idle timeoutin | 30 Seconds
[v Release only one waiting job at a time
v Allow users to cancel their print jobs
[ Use Windows &ctive Directory Account and Password to release or cancel the print job
Usze Account and PIM in Print Management Server Preferences --»> Users / Groups to
release or cancel the print job
[ Use Self payment equipment to releaze the print job Standard Card Reader j
Frint Release Station
[~ Convert unresolved [P address to computer name
[ Display keyboard on the touch screen to input uzer id or password
I 300  AM ¢ PM [For best performance]
Save
< |
Selected Waiting Jobs Total Pages: 0 Total Cost: 0.00

5. EnterSend a print job from a client computer. The print job will be hold in Print Release Station ->

Waiting Jobs.
2 | X
A | & | X
Refresh Prink Cancel
- ':‘Q Print Jobsz Uzer Computer | Description Pages | Cost | Submitted

- & Waiting Jobs
n adminiztrator

Uninstall CZ Print Release Station 3.0

1. Open Add/Remove Programs.

2. Select CZ Print Release Station.

3. Click on the Remove button.

19




Part Il Installation Options and Examples
For latest version, please visit http://www.czsolution.com/print-management/pjt _knowledge.htm

CZ Print Job Tracker 6.0 can track and control printing for the following types of printers:

1. The shared printers on the print-server computers

2. The printers connected to the network directly via the IP address without using a print server
3. The printers connected to the workstations locally

4. The printers connected to the print-server device e.g. HP JetDirect

CZ Print Job Tracker

o 39 R
E::éﬁzé RO B

print-server 4, printers on the =t —
device print-server device -
| {e.g. HP JetDirect)

«p int-server
mputers

\ workstations
\ \ \ JIN

1, :I;ared printers on the pnnt%g computers J
el IR
3, workstation-connected pnnters\_\l_} _%Jg Q g Qg

3 -

"

Windows mllac.-'Lime-'Unix 052

Installation Options and Examples that require only CZ Print Job Tracker 6.0

If you don’t need print job confirmation / authentication / billing by client code / print job tracking for
workstation-connected- printer / print job tracking for a non-print-server printing environment that CZ Print
Job Agent provides, you can install only CZ Print Job Tracker 6.0 to track and control the print jobs.

Option 1: Install CZ Print Job Tracker 6.0 on a central computer

1, Install CZ Print Job Tracker 6.0 on a central computer by following the instructions in Part | (Page 2).

2, If you already have print servers on your network, you can simply add the shared printers onto those
print servers (e.g. \\print_server\printer_shared_name) to the computer where CZ Print Job Tracker is

installed. To add the network printers to the CZ Print Job Tracker computer, you can follow the "Add
Printer Wizard" and select "Network Printer".

20


http://www.czsolution.com/print-management/pjt_knowledge.htm

*® Printers and Faxes |Z : :

File  Edit ‘Wiew  Faworikes Tools  Help a’

@Back = '\_;l Lﬁ pSearch H__ Folders v éNorton Antivirus Q -

| MName v Docurnents Sktatus A
Printer Tasks Lg8, Oce 9400 PoskScript on Printserver? o Ready

[EI. add & printer L2 Minolta 5P 3500 on PrintserverZ u] Ready
ég:g.Lexmark Optra 5 PS on Printserverz a Ready
= g:ﬁf;lra ooz s HP LaserJet 8000 Series PS on printservers u] Ready .
vig | -

3, After the printers have been added, you can then click refresh button and add these network printers from
the list of available local / network printers to the list of monitored printers in the menu item “Print Jobs --
>Preferences-->Printers” of CZ Print Job Tracker 6.0.

Preferences
Prirters | Print Jobs | Users / Groups | Poicies | Advanced |
Monochreme base cost [ page 010

Fou duplexad pinting. the cost decrease 20 % perpage
Fot calee printing. the cost increase 50 X per page

Papes Size Charging |

M aximum pages per prnt job 500

Available Local / Metwark Frinbers
Printzerver2\HP Lasedlat 4 N
WPIimzerse 2%HP Lazedlet 55i )=
Wwpiintserver\HP Laserl et 8000 Senes PS
WhPrintzersar 2 Lexmalk Optra S PS
WRiintzerver 2vMinelts SP 3500 »
Y Prirtearaar L ea QAN PrckS -nn
L] >

Relresh Hadd

Monkcsed Prinkess

|_Pririter |Bml’.‘a¢:|0ﬂuk I:duXILi'MPEIJob I
WWPrintserver2\E pson Ri<-80 0.10 -20 +50 500 pages
WWPrintserver 2AHP Lasen)et 4050 .0 0,10 =20 +S 500 pages
WWPrnkserver 2HP Laser)et 500+ 0.10 =20 +50 500 pages

Aetwnrk Frinters
Option 2: Install CZ Print Job Tracker 6.0 on your current print server computers

If you install CZ Print Job Tracker on a print server computer, it can track not only the printers on the local
print server, but also the printers on the other print servers.
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Preferences

Frinters | Puint Jobs | Usess / Groups | Pobicies | Advanced |
Monochrome baze cost / pags IW
For duplesed prnting, the cost decease | 20 % per page
For color prinbing. the cost inciesss IT % par page

Paper Size Charging |
Il aimeim pages per pink job 500
Aailable Local f Mebeork, Printeds
Ala Dee 9400 PastS criph on Printsere? ¥

Brother HL-S07(N BR Script_PS
Brother HL-S070N series_PCL

CanonimageRUNNER Color C3200

HF Lazarlet 6P v
£ »
Refiech Flemonve

Manitored Prirters

Frinter | Bage Cost | Duples % | Color % | Linit PerJob |

\wPlrinkzerwes Z\E paon R-E0 oo =20 +50 500 pages

WwPuintzerves 2\HP Lagealet 4050 ., 010 -20 =50 500 pages

WWPrintsesves VHP Laseal el 500+ 010 -2 +50 500 pages

HP Calor Lazes)et 3500 Sesies 010 - =50 500 pages

HP Desklet 540 a1 20 =50 500 pages

HP Lazeslat 5 oo =20 <80 500 pages

Local printers on this print server and the printers
an printserverz,

Installation Options and Examples that require both CZ Print Job Tracker 6.0 and CZ Print Job
Agent 1.0

Option 3: Install CZ Print Job Tracker on a Central Computer or a Print Server computer and
install CZ Print Job Agent on the workstations as needed for the following five scenarios

Note: CZ Print Job Tracker 6.0 must be installed and run before CZ Print Job Agent is installed and run on
the workstations.

1, Install CZ Print Job Tracker 6.0 on a central computer or a Print Server computer by following the
instructions in Part | (Page 2).

2, If you already have print servers on your network, you can simply add the shared printers on those
print servers (e.g. \\print_server\printer_shared_name) to the computer where CZ Print Job Tracker is
installed. To add the network printers to the CZ Print Job Tracker computer, you can follow the "Add
Printer Wizard" and select "Network Printer".

*® Printers and Faxes

File Edit W¥iew Favorites Tools  Help a'

@Back = J l_@ ;j Seatch U Folders v ;Norton ankittirus E -

[Mame Docurmnents Skatus A
Printer Tasks —

|

= | Bg,Oce 9400 PostScript on Printserwer2 u] Ready
@ Y T —— LsMinolta SP 3500 on PrinkseryverZ 0 Ready
P gt Lexmark Optra 5 PS on Printserver2 0 Ready
= |I:nris|:f;|ra levee (s L2, HP LaserJet 8000 Seties PS on prinkserverz u] Ready
€ | e
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3, After the printers have been added, you can then click refresh button and add these network printers from
the list of available local / network printers to the list of monitored printers in the menu item “Print Jobs --
>Preferences-->Printers” of CZ Print Job Tracker 6.0. .

Preferences

Printers | F"l'rtdubsl Usua.r’Erl:q:lsI P\:rh:ml .ﬁ\.l:hram:xm:ll

onocheome baze cost £/ page IW
For duplexed prinling, the cost deciease | 200 % per page
For colos pinting. the cost incresss IT X par page
Paper Size Charging |
bl ssirnuim pages per print job [s00
Avyailsble Local £ Mebaork Prinkess
Ao Do S400 PoslScrigh on Printseive2 ~

Erother HL-S070M BR-Script3_PS
Brrother HL-S070M series_PCL
Canon imageRUNMER Color C3200
HF Lasarlet 6F

O
£ *
Fefiezh FRemonme
Monitared Prirders

Prinber | Base Cost | Duplex % | Color % | Limit Per Job |
S Print sedver ZVE paon Ri=-E0 oo =20 «50 500 pages
‘“Whrinkceswes ZVHP Lagedlet 4050 ., 010 -20 =50 500 pages
“hPrint rerves ZVHP Lagses)et SO0+ oo -20 50 500 pages

HF Calor Lazer)et 3500 Series oo =20 +50 500 pages

HF Dieshlet 540 oo -20 =50 500 pages

HP Lazeslat 54 oo =20 =50 500 pages

Local printers on this print server and the printers
oh printserver?.,

The above printer settings are applied to Scenario 1, 2, 3 and 4.
Scenario 1: You want to enter project code or client code before the print jobs actually print in order to bill
back your clients. In this scenario, CZ Print Job Agent needs to be installed on the workstations (Windows,

Mac OSX / Classic, or Linux client computer) that require the entering of a code before the print jobs will
print.

S1.1 Select the following options in the menu item “Print Jobs—>Preferences—=> Advanced”.
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.z Preferences

Printers ] Pririt Jobs] Users IGroups] Policies  Advanced l

Print Jok Agent (Print Motification £ Print Authentication f Cliert Billing)
Enable agent communication

Agent is installed on Citrix f Terminal server
Hide agent system tray icon on the warkstation while agent iz running

Track only the printers inthe lizt of Monitored Printers under Printers tab
Track workstation direct IP printer or workstation connected printer via USB or LPT cable
Popup confirmstion on the workstation when s print job is submitted, except

71717171+

Pause the print job on the print server until the Print button is clicked on the popup

Enable print job authentication or charge to 5 different account
Prirt Jok Cuwener " Another Uzer f+ |Billing Code
I

I e B

[ &llow to change the print job (document) name on defined workstations
[ Al to type cliert billing code on the workstation
B I B
[ Require print job owner's PIM [ Reguire another uzer's PIk
[ UseWindows Active Directory user password
[ Enable batch print mode to hide the popugp
[ Show client biling code dropdoven list bazed on the User's Group
[v Show the column of print job sender in the main window of printed jobs

Te=t Popup Yindow Check Agent Status

Popup Timeout 3 minutes Activate Button 3 seconds (1-9)

Frint A elease Station
[~ Enable Print Release Station

{Help}

Printers

Billing Code

S1.2 Click “Billing Code” to add the new client billing codes.
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ix

4

Retfresh |

st |

Cliert (2]
Billing Code | Pages Printed | Cost | Group
abc_ 123 1] 0.00 Print Users

0.00 Print Users

Import |

[E>
Setcost  [0.00 Set Group | ]
Export | Print | Ao | Remove | Eclit Group | Exit |

S1.3 Install CZ Print Job Agent on the workstations (Windows, Mac OSX / Classic, or Linux client
computer) by following the installation instructions in Part | (Page 5). After installation, click “Start->
Programs—> Startup—>CZ Print Job Agent” to start the agent.

S1.4 Enter IP or host name of the central computer where CZ Print Job Tracker 6.0 is installed.

Note: This information is required when you run CZ Print Job Agent on the workstations the first time and
it will be saved in the file tracker_ip.ini located in the installation folder of CZ Print Job Agent and value
data of string CZPJT _IP in the registry key: My ComputenHKEY_ LOCAL_MACHINE\SOFTWARE\CZ
Print Job Agent. The installation file CZ Print Job Agent.msi can be modify to include the name/IP of
your CZ Print Job Tracker computer, so you don’t have to enter it manually when CZ Print Job
Agent is started the first time on each workstation. Please refer to the Silent installation in Part |

(Page 7).
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.z CZ Print Job Agent 1.0.0.66

IP Address [ Computer Mame

Please make sure CZ Print Job Tracker iz running and the option "Enable agent communication” is
checked in the menu itetn "Preferences --= Advanced" of CZ Print Job Tracker,

IP &ddre=z or Computer Mame of CZ Print Job Tracker

| serverl

Ok Cancel

S1.5 When a user sends a print job from a workstation, the print job is paused by CZ Print Job Tracker
(The option “Pause the print job on the print server is checked in CZ Print Job Tracker Preferences -
Advanced) and a popup window appears on that workstation for the user to select the Billing Code in
The dropdown list. When the “Print” button is clicked, the print job is printed out.

{1z CZ Print Job Agent X

Print Job Confirmation
Documert |http:.-"f"www.czsulutiu:un.u:u:urn.-"print_managemenh"czpit.htm
Frirter |'\'\|:Iffic:e1 YHPF Lazer)et 5000 Series PS
Pages |9 Cost |':'-9
Biling Code | | wem |

[Prirt Users)
Uzer _ PR |

efg_456

Pririt | Cancel

Scenario 2: You want users to be able to confirm or cancel the print jobs before the print jobs can be
printed. In this scenario, CZ Print Job Agent needs to be installed on the workstations (Windows, Mac OSX
/ Classic, or Linux client computer) that require print job confirmation.

S2.1 Select the following options in the menu item “Print Jobs—>Preferences—> Advanced”of CZ Print Job
Tracker on the central computer.
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f.x CZ Print Job Tracker Preferences

Printers | Print Jobs | Users /Graups | Policies  Advanced

CZ Print Job Agent (Print Motification J Print Authentication § Client Billing)

[v Enakle agent communication

[ Agent iz installed on Citrix / Terminal zerver

[ Hide agent system tray icon on the workstation swhile agent iz running

r

[ Track anly the prirters in the list of Manitored Printers under Printers takb

[ Track workstation direct IP printer or workstation connected printer via USB or LPT cable
[v Popup confirmation on the waorkstation swhen & print job is submitted, except

[v Pausze the print jokb onthe print server until the Print button is clicked on the popup

[ Enahle print job suthentication or charge to a different account

% Prirt Job Cwner " Ancther Uzer i
[ Require PIN B
-
[ Allow to change the print job (document) name on defined vworkstations
-
I B ™
™ B
r
[ Enable batch print maode to hide the popup
-
-

Test Popup Window Check Agert Status

Popup Timeout 3 minutes Activate Button 3 seconds (1-9)

Print R elease Station
[~ Enakle Print Release Station

{Help}

Printers

_Biing Code |

S2.2 Refer to S1.3. (Page 25)

S2.3 Refer to S1.4. (Page 25)

S2.4 When a user sends a print job from a workstation, a popup window appears on that workstation.
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fr CZ Print Job Agent X

Print Job Confirmation

Document |http:f'.-"www.czsu:ulution.u:u:umf'print_management.-"czpit. hitrii
Prirter |'\'\I:Iffi|:e1 MHP Lazerlet 5000 Series PS5

Pages |9 Cost |D-9
Biling Code | AL |

User |Giary PiRd |

Your account has a balance of 6.55

Print |

The print job is paused by CZ Print Job Tracker (The option “Pause the print job on the print server is
checked in CZ Print Job Tracker Preferences = Advanced). When the user clicks the “Print” button, the
print job is printed out.

Scenario 3: You require users to enter pin before the print jobs can be printed. In this scenario, CZ Print
Job Agent needs to be installed on the workstations (Windows, Mac OSX / Classic, or Linux client
computer) that require print job authentication.

S3.1 Select the following options in the menu item “Print Jobs—>Preferences—> Advanced”of CZ Print Job
Tracker.
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fx Preferences

Frinters ] Print Jobs l Users ! Groups ] Policies  Advanced I

Print Job Agent (Print Maotification J Print Authentication f Client Billing)

[v Enakle agent communication

[ Aoent iz installed on Citrix £ Terminal server

[v Hidle agent system tray icon on the workstation while agert i running

-

[ Track only the printers in the lizt of Monitored Printers under Printers tab

[ Track warkstation direct IP printer aor warkstation connected printer wia USB or LPT cahble
[+ Popup confirmation on the workstation when a print jok is submitted, except

[ Pausze the print job onthe print server until the Print button iz clicked on the popug

[v Enakle print jok authentication or charge to a different account

{* Print Job Cwner " Another User {

[v Require PIN [ Use windows Active Directory user password
[ Reguire to change PIM the first time # is used
[ Allow to chanoe the print job (document) name on defined swarkstations

-
I B B
™ ™
-
[ Enable batch print mode to hide the popup
-
-
Test Popup Window Check Agert Status

Popup Timeout 3 minutes Activate Button 3 seconds (1-9)

Frint Release Station
[~ Enable Print Release Station

{Help}

Printers

_ Gl ode |

S3.2 Refer to S1.3. (Page 25)

S3.3 Refer to S1.4. (Page 25)

S3.4 When a user sends a print job from a workstation, a popup window appears on that workstation.
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fr CZ Print Job Agent X

Print Job Confirmation

Document |http:f'.-"www.czsu:ulution.u:u:umf'print_management.-"czpit. hitrii
Prirter |'\'\I:Iffi|:e1 MHP Lazerlet 5000 Series PS5

Pages |9 Cost |D-9
Biling Code | AL |

User |Gary FIN |

Your account has a balance of 6.55

Print |

The print job is paused by CZ Print Job Tracker (The option “Pause the print job on the print server is
checked in CZ Print Job Tracker Preferences = Advanced). When the user clicks the “Print” button, the
print job is printed out.

Scenario 4: You require users to enter user name and pin before the print jobs can be printed. In this
scenario, CZ Print Job Agent needs to be installed on the workstations (Windows, Mac OSX / Classic, or
Linux client computer) that require print job authentication.

S3.1 Select the following options in the menu item “Print Jobs—> Preferences—> Advanced”of CZ Print Job
Tracker. This scenario also apply when all users use the same windows login account, and you want to
Be able to identify who prints, you must select “Another User” and create accounts for each user in
“Print Jobs—>Preferences—>Users/Groups”.
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f'x Preferences X

Printers ] Print Jobz ] Users [ Groups ] Palicies  Advanced l

Prirt Job Agent (Print Motification f Print Authentication § Client Billing)
{Help)

Iv Enable agent communication

[ Agent iz installed on Citrix f Terminal server

v Hide agent system tray icon on the workstation while agent is running

-

[ Track only the prirters in the list of Manitared Printers under Printers tak

[ Track workstation direct IP printer or workststion connected printer via USB or LPT cable

v Popup confirmation on the workstation when & print job is submited, except Frinters
Popup Timeout 3 minutes Activate Button ] seconds (1-9)

Iv Pauze the prirt job on the print server until the Print button is clicked on the popug

W Enahle print job authentication or charge to & different account

" Print Jab Ovener f+ Another User {

v Reguire PIN [ UszewWindovws Active Directory user passyword
[ Require to change PIN the first time it iz used
[ Allow to change the print job (document) name on defined workstations

-
r r r [ &

r r

-

[ Enahble batch print mode to hide the popup

-
-

Test Popup Wincouw Check Sgent Status |

Print Feleaze Station

[ Enakle Print Release Station

S3.2 Refer to S1.3. (Page 25)
S3.3 Refer to S1.4. (Page 25)

S3.4 When a user sends a print job from a workstation, a popup window appears on that workstation.

CZ Print Job Agent

Frint Job Confirrmation

TEEmiEh |http:.-".-"www.u:zsu:ulutiu:un.u:u:um.-"print_management.-"u:zpit.htm

Prirter |HHfoice1 "HF Lazer et 5000 Senes PS

Pages |El Cozt |':|-El
Sharedt | ML
Uses | PN
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The print job is paused by CZ Print Job Tracker (The option “Pause the print job on the print server is
checked in CZ Print Job Tracker Preferences = Advanced). When the user clicks the “Print” button, the
print job is printed out.

Scenario 5: You don’t have print servers on your network, and all workstations print to the printers directly
via the IP address of the printers or print to the workstation connected printer via LPT, USB cable. You
want to track and log the print jobs sent to these printers. In this scenario, CZ Print Job Agent needs to be
installed on all workstations (Windows computer). For more information, please refer to the Agent
installation in Part | (Page 5).

S4.1 Select the following options in the menu item “Print Jobs—> Preferences—> Advanced”of CZ Print Job
Tracker.

fr Preferences [>|

F‘rinters] Prirt Jobs] Users ! Groups ] Policies  Advanced ]

Print Jokb Agent (Print Motification § Print &uthenticstion f Client Billingg)

{Helph
| Enable agent communication
[ Agent iz installed on Citrix F Terminal server
v Hide agent system tray icon on the workstation swhile agent is running
-
[ Track only the printers inthe list of Monitored Printers under Printers tab
[v Track workstation direct IP printer or wworkstation connected printer via USB or LPT cable Computers
[ Popup confirmation on the workstation when a print job is submitted, except
[ 2 [ 3
-
-
-
r r ¢ [Biling Code
I L
-
-
-
r r r [&

=171 7171 7

Check Agent Status |

Print Releaze Station

[ Enable Print Release Station

Save | Exit |

S4.2 Refer to S1.3 (Page 25).
S4.3 Refer to S1.4 (Page 25).
S4.4 When a user sends a print job from a workstation that has CZ Print Job Agent installed, the printers is

added to the list of monitored printers automatically in the menu item “Print Jobs - Preferences =
Printers” of CZ Print Job Tracker 6.0 if the printer is not already in the list.

32



Preference

Printers | F'rintJu:uI:usI zers / Gru:uupsl F'u:uliu:iesl .-’-'xdvanu:edl
Monochrome baze cost / page IW
For duplexed printing, the cost decreases by ID— % per page
For colar printing, the cost increases by IT % per page

Paper Size Charging

kM aximum pages per print job B00

Awailable Local / Metwork, Printers

Add Remove | Email Alert |

kanitored Printers

Prirter | Base Cost | Duple: % | Calar % | Limit Per Jak
IP_HF Laserdet 5150 Series PCLE 010 0 +50 200 pages
Local_Cliert!_Lexmark X125 010 0 +50 500 pages

e ——

Update Baze. Duples. Colar, LimitAlob TDI | 010 | n | B0 X | 500
[~ Setbase costto & I 005 ) decreazed I:uyl S0 Eif prinked £ printer iz u:uver|1EIEIEIEI

[T futo change baze cost back monthly

Save | E it
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Part 111 Preferences

e Preferences --> Printers

Preferences

Monochrome base cost / page

Faper Size Charging
b aximum pages per print job

Available Local £ Network, Printers

For color printing, the cost increase

Prirbers l Print Jobs | Users / Groups ] Policies ]

n1o

For duplexed printing, the cost decrease 20 % per page

S0 * per page

s00

Epzon Stylug Pro =L ESC/P 2
HF Designlet B50C [C28534)
HP Designlet 7550

Refresh

Monitored Printers

SACF-0254eron wWork Centre Pro 40 C PS

Add

Remove

Printer | Base Cost | Duplex 2 | Color % | Limit Per Job |
WWEF-024HP Lazerlet 4 PS 010 -20 +50 500 pages
WWCF-02\Minolta SP 3500 010 -20 +50 500 pages
WWCF-02\Sharp Ji<-9700E PS 010 -20 +50 100 pages
Brother MFC-E000 010 -20 +50 100 pages

Epzon Stylus COLOR S00ESC/P 2 020 10 +40 200 pages

HF Laserlet 5 010 -20 +50 100 pages "
hdimmlbs Calar Pamstisfals B PE 1190 An AN AN Fznas

>
Update Base, Duplex, Color, Limitdeb To | [020 [ 10 % [ 40 % [ zo0
Save Exit |

Define Cost / Page

The Cost / Page includes the base cost, discount for duplex printing (printing on both sides of the paper)

and extra costs for color printing.

Example:

Base cost: $0.10 Duplex Discount / page: 20% Color cost / page: 50%

The total cost for 10 pages with duplex and color printing: 10 * (0.10 - 0.10 * 20% + 0.10 * 50%) = $1.30

The total cost for 10 pages with color printing: 10 * (0.10 + 0.10 * 50%) = $1.50

Paper Size Charging

Paper Size Charging

Increase by %
Letter 8 142 x 11 in
Letter Small 8 152 x 11 in
Tabloid 11 % 17 in
Ledger 17z 11 in
Legal 8 1/2 x 14 in
Statement 5 1/2x & 1/2in
Executive 7 1/4 1 10 1/2 in
43 297 x 420
44 210 x 227 mm
A4 Small 210 x 297 mm
45 148 x 210 amam
B4 (JIS) 250 x 354
ES5 (JI5) 182 x 257 mm
Folic & 1/2 x 13 in
Guarto 215 x 275 mm
10:14 in
11x17 in
Hote & 1/2x 11 in
Ervvelope #2 3 748 x 8 78
Envvelope #10 4 148 x 2 1/2
Emvelope #11 4 102 x 10 3/8
Emvelope #12 4 %3 11
Envvelope #14 5z 11 1/2
C size sheet

Sfleloflelfeel={lefele{=fel=[efel

Increase by 2%

D size sheet

E sime sheet

Envelope DL 110 x 220 mm
Envelope C5 162 x 229 num
Envelope C3 324 x 458 mm
Envelope C4 229 x 324 mm
Envelope C& 114 x 162 mm
Envelope C65 114 x 229 mum
Envelope B4 250 x 353 mm
Envelope BS 176 x 250 mm
Envelope B& 176 x 125 mm
Envelape 110 x 230 mm
Envelope Monarch 3.875 2 7.5 in
& 3i4 Envelope 358 x 6 142 in
TS Std Fanfold 14 28 x 11 i
German 5td Fanfold 8 102 x 12 in
German Legal Fanfold 2 1/2 x 15 in 5]
Ed4 (I30) 250 x 353 mm
Japanese Postcard 100 x 148 mm
Fxllin

10z 11 in

15x 11 in

Envelope Invite 220 x 220 mm
Letter Extra @ %22 12 in

b
=]

SHHF FHFHRHF PR Fe

a

Increase by 2%
Legal Extra @ ¥2x 15 in
Tabloid Extra 11 8% x 18 in
44 Extra 927 x 1269 in
Letter Transverse 8 ¥2x 11 in
A4 Transverse 210 x 297 mm
Letter Extra Transverse 2% x 12 in 20

SuperdsfSuperhiid 227 x 356 mm Z0
SuperBfSuperBfAT 305 x 487 mum =0
Letter Phis 8.5 x 1262 in

A4 Phas 210 x 330 mum 20

A5 Transverse 148 x 210 mm

B5 (JIS) Transverse 182 x 257 mm
A3 Extra 322 x 4435 mm 30
45 Extra 174 x 235 mm

B5 (I50) Extra 201 x 276 mm
A2 420 x 5394 mm 30
A3 Transverse 297 x 420 mm 20
43 Extra Transverse 322 x 445 mm | 30
Japanese Double Post 148 x 200mm | g

o[l =l

45 148 3 105 mm 0
Arch El - 30"42" [s0
Arch D - 24"x36" =0
Undefined Paper Sizes
Cancel
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Example:

Base cost: $0.10 Duplex Discount / page: 20% Color cost / page: 50%

The total cost for 10 pages with duplex and color printing on A3 297 x 420 mm:
10 *(0.10- 0.10 * 20% + 0.10 * 50% + 0.10 * 20%) = $1.50

The total cost for 10 pages with color printing on C size sheets:

10 *(0.10 + 0.10 * 50% + 0.10 * 30%) = $1.80

Undefined Paper Sizes

“f CZ Print Job Tracker

Add Undefined Paper Sizes
Paper Size Increase by % Paper Size Increase hy %4
Tndefined 21

Undefined 1 [27.00 = 39.00 in

Undefined 2 Tndefined 22

Undefined 3 Tndefined 23

Undefined 4 Tndefined 24

Undefined 5 Tndefined 25

Undefined & Undefined 26

Undefined 7 Undefined 27

Undefined 8 TUndefined 28

Undefined 2 TUndefined 22

Undefined 10 TUndefined 30

TUndefined 31

Undefined 12 TUndefined 32

Undefined 13 Undefined 33

Undefined 14 Undefined 34

Undefined 15 Undefined 35

Undefined 16 Undefined 3&

Undefined 17 Undefined 37

Undefined 18 Undefined 32

Undefined 19 Undefined 32

EEEEEEEEEEEEEEEEEERE
RERRERREEEREERERERER

I
I
I
I
I
I
I
I
I
Undefined 11 |
I
I
I
I
I
I
I
I
I

Undefined 20 TTndefined 40

Ok | Cancel |

If "Undefined #" is shown on the CZ Print Job Tracker main screen --> Printed Jobs, then you can click the
menu item "print jobs --> Preferences-->paper size charging-->undefined paper sizes" to defined the
"undefined #"

Maximum pages per print job
The print job which exceeds the limit will be deleted automatically. If the service “messenger” is started on
both CZ Print Job Tracker and user's computers, the user will get the alert message.

Available Printers

The available printers include all printers on the CZ Print Job Tracker computer. They can be network
printers (\\print server\shared printer name) and local printers with LPT, TCP/IP or LPR ports. Multiple
printers can be selected by holding down the 'Ctrl' key to select printers to be added to the list of monitored
printers.

Refresh Printer List
Refresh the list of available printers. After you add / remove a printer to / from the CZ Print Job Tracker
computer, you can click the refresh button to refresh the list.

Monitored Printers
Multiple printers can be selected by holding down the “Ctrl” key to removed them from the list of
monitored printers.

Update Cost

1, Define the new value of the base cost per page, duplex, color or limit per print job.
2, Select one or multiple printers from the list of monitored printers and click update button.
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e Preferences --> Print Jobs

Frinters : Users.-’Groups] F'olic:ies] Advanced]
Deleted / Printed Jobs
Show printed jobs by ¥ User [+ Computer ¥ Printer

Show deleted and printed jobs from | a A7/2006 ﬂ ta | o M 7A2006 ﬂ

v Auto reset date range to the curent date every one hour

v Auto refresh printed jobs every W secohds

Iv Optimize printed jobs

W aiting Jobs

v Auto delete all waiting jobs at W o Ak PM

[ Auto delete the waiting job if it iz held mare than ’T haurs

[ Auto delete the first waiting job on each printer if it iz held more than ’T minutes

Miscelanea

Databaze directony | J
I [z00 @& &M M Translate
v Auto backup / optimize database if the size is greater than W ME OR Scheduls
[~ Corwvert unresolved |P address to computer name:

[~ CZ Print Job Tracker is installed on Citriz / Terminal Server
[~ Enable pazsword protection for preferences

Save E it

Show Printed Jobs
Show Printed Jobs by the user id, computer name and printer name.

Auto Delete the first waiting Job on each printer
If the first print job in the printer queue is held too long, it may be a print job that is stuck and might cause
other print jobs to be held in the queue.

Update Database for Reports
Finalize the records in the database so you can use the free tool CZ Print Job Report to generate and view
100 different reports. Updating the Database for Reports can be done according to the scheduling.

Report Translation
Translate 100 reports to other languages.

Backup and Optimize Database
We recommend backing up and optimizing the database when its size exceeds 100MB (about 300,000 -
400,000 print job records) to improve the performance of CZ Print Job Tracker 6.0.

The database is copied to the “backup” folder (e.g. C:\Program Files\CZ Solution\CZ Print Job
Tracker\backup) and is named as the current date. (e.g. 020105.mdb), then the database is reset to be empty
for the best performance of CZ Print Job Tracker. This operation can be run automatically by setting the
database size or schedule. If you want to merge multiple databases into one, you can click the menu item
Print Jobs --> Merge Database.

Running on Citrix / Windows terminal server
If CZ Print Job Tracker is installed on a Citrix / Windows terminal server, this option must be checked.
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e  Preferences --> Users / Groups

Printers ] Frirt Jobs Uzers / Groups l Policies ] Advanced ]
User List
Lzer | Pages Printed | Balance | Group | FIH | Status
addy 21 10.00 Marketing 423 Enabled
adele ar unlimited Management E55E Enabled
balie 144 420 Operations Enabled
bernet 33 350 Operations E7E4 Enabled
bill 1] urlirnited Pritt Ugers 7aE7 Enabled
bob 45 234 Marketing Enabled
[etats)) 64 3.80 Research Enabled
eleri 73 unlirnited IT Enahled
fred 70 380 Marketing Dizabled
garry 34 10.40 IT 2345 Enabled
ohnson [} 244 Finance Enabled
kaeli 29 5.34 Research Enabled
kal 25 260 Management E57S Enabled
larmy 38 unlimited Finance Enabled
madera 25 780 IT Dizabled
makai 29 unlimited Operations Enabled
mike 25 urlirnited Finance 3578 Enabled
pese 20 870 Research 3456 Enabled
peter 42 8.54 Operations Enabled
pontea 42 258 Research a7ar Dizabled
praize 4 876 Operations Enabled
tarmrny 9 unlimited Fesearch Enabled
tamsen 18 965 Finance 456 Enabled
tom 29 unlimited Operations Enabled
Set Balance «| SetGroup |Management j SetPIM
Refresh | Import | Export | Frint | Add | Remove | Edit User | Edit Group |
Save | E it

Users Status
You can prevent the print job from printing that is submitted by a disabled user account in "Policies." You
can also set the user account age in "Policies.”

Set PIN
To authenticate the print job before it actually prints, a pin needs to be set for the users and the add-on CZ
Print Job Agent must be installed on the user's workstation.

Import

The users / groups can be imported from the Windows Active Directory. The users / pin can be imported
from a CSV file (samples: http://www.czsolution.com/download/ImportFiles.zip). The new users can be
added to the database automatically when they send a print job.

Export
Export the list to a file in Excel, HTML and Text format.

Add user
You don't have to add the users manually. The users can be added to the database automatically when they
send a print job.

Edit Group

The default group is called "Print Users."” You can add a new group (department) and assign users to it,
then you are able to monitor the printing based on the group (department).
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e Preferences --> Policies

F'rinters] PrintJohs] gers / Groups  Policies lAdvanced]

Balance
[v Setinitial balance for the new user to enable balance tracking 20.00
[v Deny printing if the balance is less than or equal to 0

[~ Send a message to the user
|Y0ur print job will not be printed. Please contact the administratar.

v |F|eset balance based an group ﬂ [ Mow | & Daly  Schedule

User

W Disable user account aftef | 180 days when it was created

[ If the print job is sent by disabled accounts ~ -
-

Computer

[v If the print job iz sent from theze  Computers * pauzeit (" deleteit

[~ Send a meszage to the user
|Y0ur print job will not be printed.  Please contact the administrator,

Docurnent Title
[v If the print job title contains these Shings (» pauzeit (" delete it

[~ Send a message to the user

|Y0ur print job will not be printed. Please contact the administrator.

hore Palicies
Save | Exit |

Balance

Set the initial balance for the new users when they print. This also enables balance tracking for all

users. For example, if you set the initial balance to $20.00, and a new user submits a print job with a cost of
$5.00, then the new user will be added to the list of "Users/Groups" automatically and the new user's
balance will be $15.00.

If you disable balance tracking, all users will have an "unlimited™ balance.
The balance can be reset manually or by a schedule in three ways:

1: Reset balance to: All users' balances are reset to the value you define.

2, Increase balance by: All users' balance is increased by the value you defined.

3, Reset + balance to And add - balance to: For example, if A user has a positive balance of $2.00 and B
user has a negative balance of -$3.00, and you set the value to $20.00, then after this operation, A user
has a new balance of $20.00 and B user has a new balance of $17.00.

4, Reset balance based on groups: click "Edit Group" in "Preferences --> users/Groups" and define the
balance to be reset.

User Restrictions
The user accounts are listed in "Users/Groups.” The status of a user account can be updated manually by
clicking the "Edit User" button in "Users/Groups."

Document Restrictions

Define the specific strings or specific file types in the document title of a print job that will not be printed.
For example, if you define the string "gif", then a print job with the string "picture.gif” in the title will be
paused or deleted automatically. If you define the string "document*.doc", then the print job with the string
"documentl.doc" or "document2.doc’ will be paused or deleted automatically.

38



More Policies

Pagesz Per Job
v Ifthe print job exceeds the page limit / job of the pinter @ pause it O delete it

[ Send a popup message bo the Lser

|Your print job will not be printed because it exceeds the maximum allowable page limit p

Calar
[v If the print job iz color sent from these Users f pauzeit O deleteit
[~ Send a meszage to the uzer

|Your print job will not be printed. Please contact the administrator.

Size:
Iv i the print job size iz areater tharg | 850 B o pauseit (" deleteit

[ Send a message to the user

|Your print job will not be printed,  Please contact the administrator.

Ok Cancel

e Preferences --> Advanced

f.x Preferences X

Printers ] Frirt Jobs ] Uszers [ Graups ] Policies  Advanced ]

Print Job Agert (Print Matification § Print Authentication § Client Billing)
{Help}

[v Enakle agent communication

[ Agent iz installed on Citrix / Terminal server

[V Hide agent aystem tray icon on the workstation while agent iz running

r

[ Track only the printers in the list of Monitored Printers under Printers tak

[~ Track wworkststion direct IP printer or vworkststion connected printer via USB or LPT cable

[v Popup confirmation on the waorkstation wwhen & print job is submitted, except Printers
Popup Timeout ’T minutes Activate Button IT seconds (1-9)

[v Pause the print job onthe print server until the Print button is clicked on the popup

m

[ Enahle print job suthentication or charge to a different account

" Print Job Owner &+ Ancther User {

v Reguire PIN [ UszewWindows Active Directory user passvword
[ Reguire to change PIM the first time it is used
[ Allow to change the print job (document) name on defined workstations
-
r r r [ &
™ B
-
[ Enakle batch print maode to hide the popugp
-
-

Test Popup wWindow Check Agent Status |

Frint Release Station
[ Enakle Print Release Station

39



Enable Agent Communication
Please refer to the above Installation Option 1 & 2
A add-on CZ Print Job Agent needs to be installed on the workstations as needed.

Hide Agent Icon
If this option is checked, then the CZ Print Job Agent icon will not show on the system tray when it is
started.

Allow Exit
If this option is checked, then users can exit CZ Print Job Agent by right-clicking the icon on the system
tray and selecting exit.

Popup Confirmation Window

The popup confirmation window can be used for print job confirmation, print job authentication and
client/project billing. You can configure the following four fields: Billing Code, User, and User PIN
depending on your requirements. After configuration, you can click "Test Popup Window" to see the popup
window that will also be shown on the workstations with CZ Print Job Agent installed.

Example 1: Users are required to confirm the print job before it actually prints.

In the menu item “Print Jobs-->Preferences-->Advanced"”, only the option "Popup confirmation on the
workstation when a print job is submitted" needs to be checked.

2 CZ Print Job Agent

Print Job Confirmation

|http:a"a"www.u:zsc-luti-:n.u:c-m.n"print_management.n’-:zpit.htm

Document

Pririter |\\foice1 WHP Lazerlet 5000 Senes PS5

FPages |El Cost |D-8
Shared# | L
User |F'rintJ obwrer FIN |

Your account haz a balance of 6.5%

Pritt |

Example 2: Users are required to enter the pin before the print job actually prints.

In the menu item “Print Jobs-->Preferences-->Advanced", the option "Enable Print Job Authentication or
Charge to a different account™ and option "Require PIN" need to be checked.

CZ Print Job Agent

Print Job Confirmation

|http: A, czzolution. com/print_management/czpit. htm

Docurment

Prirter |\\foice1 WHP Lazerlet 5000 Seres PS

T |9 Cost |U-9
Shared | =1 wem |
|zer |F'rint.J0bDwner FIM |m,1

Your account has a balance of 6.55

Print Cancel |
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Example 3: Users are required to select or enter Billing Code (client code or project code) to be charged
before the print job actually prints.

In the menu item “Print Jobs-->Preferences-->Advanced", the option "Enable Print Job Authentication or
Charge To a different account” needs to be checked and "Shared Account # / Project #" needs to be
selected. You can also click the "Billing Code" button to add the new shared account # or project #.

% CZ Print Joh Agent

Prirt Job Confirmation

|http:waw.czsolution.com.n’print_managemenb’czpit.htm

Document

Frinker |\\foice1 “HP Lazerlet BO00 Senes PS

o= |9 Cost |D-9
Shared t |4545 BT
Llser |PrintJoI:-Dwner PN |

Frint | Cancel |

Example 4: Users are required to enter Billing Code, user and user PIN.

In the menu item “Print Jobs-->Preferences-->Advanced", the option "Enable Print Job Authentication or
Charge to a different account”, “Another user” and "Require PIN" need to be checked.

‘> CZ Print Job Agent

Frint Job Confirmnation

|http:.-"a"www.czsu:ulutiun.u:Dm.-"print_management.-"c:zpit.htm

Document

Frinter |'x'xEIffiu:e‘I WHF Lagzer)et B000 Series PS

Pages |9 Cost |D-9
Shared # | | owen
User | PN

Frirt

Excluded Printers
If the user sends a print job to the printer in the list of excluded printers, then the popup windows will not
show on the users' workstation.

Popup Timeout

Define the time in minutes the popup will show on the workstations. If the popup window times out, then
the print job will be cancelled automatically.
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Billing Code (Client Code or Project Code)

£ Print Job Tracker

Shared Account # / Project # List
Shared # | Pages Printed Cost Group PIN
125678 23 3.90 Project
134367 o] .90 Project
143783 35 5,80 i
2342 63 9.50 Client
2456 76 10.40 Client
4345 34 5.80 Client
< | I
SetCost [0.00 Set Group || Project | SetPiM
Heflesh| |rport | E=port | Frint | Add # | Hemnveﬂ| EditGrDup| Exit |

Check Agent Status
2% CZ Print Job Tracker

CZ Print Agent Status

IP Address Computer
14.2 23 affice]
142322126 officed
142322129 officeh
142322132 officed
142322135 afficed
142322136 operation?
142322138 operationd
14.23.22139 operationS
142322147 operation?
142322149 operationd
142322152 operationd
14.23.22158 factors
14.23.22159 factor3
£

Statuz

(>

active
inactive
active
active
inactive
active
active
active
inactive
active
active
inactive

[ £

Refresh E wit
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Part IV Step by Step Configuration and FAQ
Step by Step Configuration

http://www.czsolution.com/print-management/pjt knowledge.htm

http://www.czsolution.com/print-management/userguide/QuickStart.zip

FAQ

http://www.czsolution.com/print-management/pjt fag.htm
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http://www.czsolution.com/print-management/pjt_knowledge.htm
http://www.czsolution.com/print-management/userguide/QuickStart.zip
http://www.czsolution.com/print-management/pjt_faq.htm
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